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SOLIDWORKS® 2021 Reference Guide Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SOLIDWORKS. On the completion of this chapter, you will
be able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly, and Drawing document.
e Utilize the available SOLIDWORKS Design Intent tools:

e Comments, Design Binder, ConfigurationManager, Dimensions, Equations,
Design Tables, and Features.

o Identify the correct Reference planes:
e 2D and 3D Sketching.
e Insert sketch Reference planes.
e Comprehend the Parent/Child relationship.
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found, and Invalid
Solution Found.

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve,
Point, Centerline, Text, Plane, Route line, and Belt/Chain.

e C(lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block, and Belt/Chain.
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e Recognize and utilize the following Spline tools:

e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum
Radius, and Show Curvature Combs.

e Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SOLIDWORKS definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design
changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,
part, assembly and drawing.

When editing or repairing geometric relations, it is considered best practice to edit the
relation vs. deleting it.

Design Intent in a Sketch T

Build design intent in a sketch as the profile is created. A )
profile is determined from the Sketch Entities. Example: SO
Rectangle, Circle, Arc, Point, Slot, etc. Apply symmetry ot Vertical
into a profile through a sketch centerline, mirror entity and /:( x /o
position about the reference planes and Origin. Always

Coincident Midpoint

know the location of the Origin in the sketch. “y
Build design intent as you sketch with automatic : : L oase
Geometric relations. Document the decisions made during o 7
the up-front design process. This is very valuable when Perpendiener fonaent
you modify the design later.
A rectangle (Center Rectangle Sketch tool)
contains Horizontal, Vertical, and Add Relations AN = /,/}
Perpendicular automatic Geometric % sm“ \\ 7 °
relations. . \i};-{/
Apply design intent using added Geometric ||| perendicuar " u
relations if needed. Example: Horizontal, || parale ,// N
Vertical, Collinear, Perpendicular, Parallel, % ig' v AN
Equal, etc. — ; ™

|
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Example A: Apply design intent to create a square

profile. Sketch a rectangle. Apply the Center Rectangle
Sketch tool. Note: No construction reference centerline or
Midpoint relation is required with the Center Rectangle

tool. Insert dimensions to fully define the sketch.

Example B: If you have a hole in a part that must always
be 16.5mm < from an edge, dimension to the edge rather
than to another point on the sketch. As the part size is

modified, the hole location remains 16.5mm < from the

edge as illustrated.

Design Intent in a Feature

Build design intent into a feature by addressing End
Conditions (Blind, Through All, Up to Next, Up to

Vertex, Up to Surface, Offset from Surface, Up to Body,

and Mid Plane), symmetry, feature selection, and the
order of feature creation.

Example A: The Extruded Base feature remains
symmetric about the Front Plane. Utilize the Mid
Plane End Condition option in Direction 1. Modify
the depth, and the feature remains symmetric about
the Front Plane.

Example B: Create 34 teeth in the model. Do you
create each tooth separately using the Extruded Cut
feature? No.

Create a single tooth and then apply the Circular
Pattern feature. Modify the Circular Pattern from
32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a part.
Example A: Feature order. Is the entire part
symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and using
the Mate relation between parts builds the design
intent into an assembly.

Example A: Reuse geometry in an assembly. The
assembly contains a linear pattern of holes. Insert one
screw into the first hole. Utilize the Component
Pattern feature to copy the machine screw to the
other holes.

SOLIDWORKS® 2021 Reference Guide
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Design Intent in a Drawing

Utilize dimensions, tolerance and notes in parts
and assemblies to build the design intent into a
drawing.

Example A: Tolerance and material in the
drawing. Insert an inside diameter tolerance
+.000/-.002 into the Pipe part. The tolerance
propagates to the drawing.

Define the Custom Property Material in the Part.

Note: MATERIAL $5316 ,

w004

@157
_‘T

000

01827 0%

o euns D&M ENGINEERING
me

TUBE

B 5622222 B

The Material Custom Property propagates to
your drawing.

* Create a sketch on any of the default planes:
Front, Top, Right, or a created plane or face.

SOLIDWORKS Design
Intent tools

%!E@&

%PMD }’Q Q‘DNDQ‘Q

Histor Go To...

Comments [ SensoPart (Part1)
» [&Annot Hidden Tree Items

Add comments, notes or additional information (D Equati Comment [

. . Es Materi Tree Display'
to f'eaturesior s}(etghes during the design DFront|  Document Properties.
period. This will aid you or your colleagues to (I TopP|  Configuration Publisher
recall and to better understand the fundamental [ Right | Appearance '
1, origin Material

design intent of the model and individual
features later.

#  Top Level Transparency

Purge Unused Features.

'~
’ idd Commet

Right-click on the name, feature, or sketch in
the FeatureManager. Click Comment > Add
Comment. The Comment dialog box is
displayed.
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Enter the information. Click Save and Close. A Comments folder
is displayed in the FeatureManager. Double-click the feature in the
Comments folder to view the comment.

n s
AT

You can also add a Date/Time stamp to your comment.

Design Binder

Activate the Design binder. Click Options @ » System Options
tab > FeatureManager. Select Show from the drop-down menu.
The Design Binder is an embedded Microsoft Word document that
provides the ability for the user to capture a screen image and to
incorporate text into a document.

ConfigurationManager

Design Intent, Sketching and Sketch Entities

SERS@
7

% Part1 (Default< <Default>_Display
Comments
D Comment1
History
Sensors

B

SERS@
v
@3 Part1 (Default<<Default>_Displaj
~ [EI Comments
D Comment1
History
Sensors
[[3) Design Binder
iy @ Design Journal.doc <Empty
» [A] Annotations
Equations
85 Material <not specified>
7 Front Plane
{1 Tan Dl

When you create various configurations for assemblies, design

tables, etc., use the comment area to incorporate a comment

G

h e

@

for these configurations.

- [©partl Con p, (Part1)

Configurations

- - [%@ V/ Def 'Li Add Configuration...
D I m e ns I o ns Confii}ation Publisher.,
Purge Unused Features..
To be efficient, reuse existing geometry. Provide dimensions Save Confiauration
with descriptive names. Modify
X 02 %E
Equations :
SOLIDWORKS pr.o.V1des a cqmpletely redes;gned dialog box sERe @ >
for creating and editing equations, global variables and ¢
dlmel’lSIOIlS %rsor(yl?ria:tlf <Default>_Display|
. . . [ ] Comment1
Add a comment to the end of an equation to provide clarity for felHistory
. . . . [&@lSensors
the future. Use descriptive names and organize your equations - [ Design Binder
to improve clarity. g DesionJounaldoc <Empy
i D_g Equ:tin;‘\\; -
- - B M anageL\gua ions...
5 . : 1 Fre Show File'Properties
‘¥ Create an Excel spread sheet to input your equations into H i v
SOLIDWORKS. Use the Link to external file option. Pry Gl

Equations, Global Variables, and Dimensions

%Gt

+ Filter Al Fields

Name Value / Equation

|=IGlobal Variables
| —Features

| |—Iequations
I

[ Automatically rebuitd | 8 Angular equation units:  Degrees

L‘—\ Link to external file:

Evaluates to

Automatic solve order

Comments

Import...

Export.
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w1

‘¥ Specify units of measurement for Global variables, and ° ' &
for the values and equations that define the global variables. S ER S S
You can define the units in the Equations and modify dialog S lbcez Extrude @
boxes for dimensions, and in PropertyManagers that support VX @
equations' e Sketch Plane v 3
Direction 1 A
Design Tables ‘:  EE—]
There are a number of ways to incorporate a comment into a 'De_mhi
design table. One way is to add “SCOMMENT” to the & d d
heading of a column. This provides the ability to add a obal Varipile ®nco
comment in a design table. (7 oiFunctions -
(1T %
Featu res select File Properties g
Always use descriptive names in the | 2 scrll slected tem o view
FeatureManager design tree, not the default Narme feature on creation
feature names such as Boss-Extrudel, Cut- $ﬁow key navigation
Extrudel, LPatternl, etc. Group important Dynamic highlight
features toward the top of the FeatureManager []Use transparent fiyou FeatureManager tree in parts/assemblies
deSIgn tree. Enable FeatureManager tree filter
[ Allow component files to be renamed from FeatureManager tree
- Enable preview of hidden components

‘¥ Enable the FeatureManager Name feature on
creation option: click Options > System Options > FeatureManager > Name
feature on creation box. The Name feature on creation option highlights the feature
name when created and allows the feature to be named.

Identify the Correct Reference Planes

Most SOLIDWORKS features start with a 2D sketch. Sketches are the foundation for
creating features. SOLIDWORKS provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on
an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three
default planes are aligned with
specific views. The plane you select
for your first sketch determines the
orientation of the part. Selecting the
correct plane to start your model is
very important.
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2D Sketching/Reference Planes

The three default | reference planes,
displayed in the FeatureManager design tree,
represent infinite 2D planes in 3D space.
Front.

e Top.
e Right.

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. The default L datum planes:

e Primary.
e Secondary.
e Tertiary.

Use the following planes in a manufacturing
environment:

e Primary datum plane: Contacts the part at

a minimum of three points.

Front

ight
Secondary Dajum
Terliary Datum

Top
PFrimary Dalum

e Secondary datum plane: Contacts the part at a minimum of two points.

e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

- 20-Profile - -+ FrontPlane - -+

----- TopPlane - - -Right-Planeq]
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The six principle views of Orthographic projection listed in the ASME Y 14.3 2009
standard are Front, Top, Right, Bottom, Rear, and Left. SOLIDWORKS Standard view
names correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name:

SOLIDWORKS Standard View:

Front Front
Top Top
Right side Right
Bottom Bottom
Rear Back
Left side Left

ANSI is the default overall drafting standard

used in the book.

w1

-~

N}

Tutorial: Default Reference Planes 4-1

Create a New part. Display the default Reference b A
planes in the Graphics window.
1. Click New L from the Menu bar. The
Templates tab is the default tab. Part is the
default template from the New
SOLIDWORKS Document dialog box.
2. Click OK. The Part FeatureManager is

: Displayed are the Front, Top, Right, and
Isometric views in Third Angle Projection.

ngincert)

“* D&M ENGINEERING A
o

RIGHT ANGLE
o] A Part A

1

displayed. Use the sketch Origin to understand

the (x-,y-) coordinate location of the sketch

and to apply sketch dimensions. Each sketch in the
part has its own Origin.

Click Front Plane from the FeatureManager design
tree. The Front Plane is the Sketch plane. The Front
Plane is highlighted in the FeatureManager and in the
Graphics window.

Show the default Reference planes in the Graphics window.
Select the Front, Top and Right planes.
4. Hold the Ctrl key down.

5. Click Top Plane and Right Plane from the

FeatureManager design tree.
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7. Right-click Show ® from the Context toolbar.

6. Release the Ctrl key. % “ E H}‘ ﬂ >
T

8. Click inside the Graphics window. The three planes are G Part1 (Defauit< <Defauit>_Displ
History

displayed in the Graphics window. Note the Plane icon in Sensors
the FeatureManager. » [&] Annotations

WL Equations
O

“¥* Rename a feature or sketch for clarity. Slowly click the TN Material <not specified>
feature or sketch name twice and enter the new name when ™~
the old one is highlighted.

Rename the default Reference planes. L. origingy, o
9. Rename the Front Plane to Front-PlateA.

10. Rename the Top Plane to Top-PlateB.

>
11. Rename the Right Plane to Right-PlateC. ? [E $ e

12. View the results. @ Part1 (Default< <Default>_Disp
History
13. Close the model. [ sensors
» [A] Annotations
. Equations
3D Sketching/Reference Planes 553 Material <ot specified>

[ Front-PlateA

Create a 3D Sketch in SOLIDWORKS. A 3D Sketch is typically (J Front-PlateB
used for advanced features such as Sweeps and Lofts or when (7 Front-PlateC
the sketch does not lie on an existing or easily definable plane. L. Origin
Most basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is
called 2D Sketching with 3D Sketch planes. In this approach,
you:

1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move
sketch entities to create a 3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides the ability to:
e Add relations:

e Between planes.

e Between sketch entities on different planes.

e To planes.

e Define planes.

e Move and resize planes.
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Tutorial: 3D Sketching 4-1 75 SOLIDWORKS  File Edit Vig
Create a simple 3D Sketch on plane using the line sketch tool. El & /SO
1. Create a New LJ part. Use the default ANSI Part template. - E g o R R
2. Click Top Plane from the FeatureManager. “E e ©
3. Click the Sketch tab from the CommandManager. @? zg 5:9“: o
D etch On Plane

4. Click 3D Sketch On Plane from the Sketch Consolidated %V RIS

toolbar as illustrated. 3DSketchl is active. & Par2 (Default< <Defac

s - # Histol
5. Click the Line e Sketch tool. it "EZ’ ZLN = — P& E%Se:sczs
@ el T \ﬂ < g« . » [A) Annotations

6. Sketch a vertical line through the | select W (&) Equations

Orlgln Sketch Entities ’ 55 l\/(lqaterial <not speci

Recent Commands ’ (J,Front Plane

7. Right-click Exit Sketch & from » M:’: Dimensions :

the Context toolbar. 3DSketchl is ;eczele; . Loﬁgin

displayed in the FeatureManager -

and is under defined.
8. Close the model.
Tutorial: 3D Sketching 4-2
Create the illustrated model. Insert two features: Boss-Extrudel
and Cut-Extrudel. Apply the 3D Sketch tool to create the Cut-
Extrudel feature. System units = MMGS.
1. Create a New L part in SOLIDWORKS. Use the default Origin

ANSI, MMGS Part template.

4 Annotations
Equations
[

2. Right-click Front Plane from the FeatureManager.
This is your Sketch plane.

3. Click Sketch {_ from the Context toolbar. The
Sketch toolbar is displayed.

4. Click the Corner Rectangle I3 tool from the
Consolidated Rectangle Sketch toolbar. The
PropertyManager is displayed.

ront Plane)

[Gf, 3D Sketch On Plane

5. Sketch a rectangle as illustrated. The part Origin is
located in the bottom left corner of the sketch.

Insert dimensions.

6. Right-click Smart Dimension b from the
Context toolbar.

-/ \.\
/
7. Dimension the sketch as illustrated. The sketch is \ a ~,
fully defined. The sketch is displayed in black. ] ™
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Create the first feature for the model. The Extruded
Boss/Base feature adds material to a part. Extrude the
sketch to create the first feature. Apply symmetry.

8. Click Extruded Boss/Base ﬁ from the Features
toolbar.

9. Select the Mid Plane End Condition in Direction 1.
Enter 100.00mm for Depth in Direction 1. Accept
the default conditions. Click OK ¥ from the Boss-
Extrude PropertyManager.

w1

‘¥ The Instant3D tool provides the ability to drag
geometry and dimension manipulator points to resize
features or to create new features directly in the

Graphics window. Click the face. Select a manipulator

point. Click and drag. Click a location along the ruler | 55 soupworks | Fie &

for the required dimension. The ruler increments are set &l & /0O

in System Options. sketeh) Smart ([T- /-
- - ()

10. Create 3DSketch1. 3DSketchl is a four point

Design Intent, Sketching and Sketch Entities

S BBl
@ Boss-Extrude @
X ®©

From

Sketch Plane

Direction 1
Mid Plane

‘End Condition : Mid Plane
I

®| F

Draft outward
[ Thin Feature ‘

Selected Contours ‘

2
& 100omm Depth (Enter a value or std
o1 - r

Sketch

sketch. Click 3D Sketch On Plane from the Consolidated

Sketch toolbar as illustrated. o 3D Sketch

4p 3D Sketch On Plane

11. Click the Line 7 Sketch tool. 3DSketchl is a four point
sketch as illustrated. 3DSketch1 is the profile for Cut-
Extrudel.

12. Locate the first point of the sketch. Click the back right
bottom point as illustrated. Locate the second point of the sketch. Click the top left
front point as illustrated. Locate the third point of the sketch.

13. Click the bottom right front point as illustrated.

Locate the fourth point of the sketch.
14. Click the back right bottom point as illustrated to close the sketch.

100
XY @
9.31
&

XY A™

Create the Cut-Extrudel feature.
15. Click Extruded Cut from the Features toolbar.

|
: Boss-Extrude1
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16. Click the front right vertical edge as illustrated to remove
the material. Note: Do not select the midpoint. Edge<1> is
displayed in the Direction of Extrusions box.

17. Click OK ¢ from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager.

18. Close the model.

w1

“¥* Select the front right vertical edge or the Top face to
remove the required material in this tutorial.

S ER S
The second approach to create a 3D Sketch in <=
SOLIDWORKS is 3D Sketching. In this approach: @ 3D Sketching 4-3 (Default<<De
o e [@Histo
1. Open an existing 3D Sketch. Sensonr,s
. » [Al Annotations
2. Press the Tab key each time you need to move your B Equations
sketch entities to a different axis. %Materia' supisipselisdl

" Front Plane
The sketch origin is placed wherever you start the ) Top Plane

[ Right|[2. +® €
sketch. D S A

\‘ﬁ: Edit Sketch

Tutorial: 3D Sketching 4-3 ke reorene et
Apply the 3DSketch tool to create a 3DSketch Comment
using the Tab key to change Sketch planes. o Zr:;;ﬁ:'i;ture

1. Open 3D Sketching 4-3 from the
SOLIDWORKS 2021 folder.

Edit the 3D Sketch.
2. Right-click 3DSketch from the

FeatureManager. Click Edit Sketch @ from
the Context toolbar. 3DSketchl is displayed in
the Graphics window.

3. Click the Line ¢ Sketch tool. Note: The /T\T\.
mouse feedback icon.

4. Click the right endpoint of the sketch as
illustrated.

5. Press the Tab key to change the Sketch plane
from XY to YZ. The YZ icon is
displayed on the mouse pointer.

6. Sketch a line along the Z axis
approximately 130mm as illustrated.

74

7. Press the Tab key twice to change the
sketch plane from YZ to XY. The XY
icon is displayed on the mouse pointer.
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9.

10.

30mm.

1,507
ZHr—

Sketch a line back along the X axis approximately /L

Sketch a line on the Y axis approximately 30mm. b

Sketch a line along the X axis of approximately 130mm.

Deselect the Line Sketch tool.

11.

Right-click Select.

12. View the 3D Sketch.
S ERS @
13. Close the model. < ‘ ‘ ‘ T
& @ 3D Sketching 4-3A (Default<
Tutorial: 3D Sketching 4-3A » [@lHistory
Apply the circle sketch tool to create a Sweep along a 3D ’ ie"“zrsf
sketch. Eequstions
1. Open 3D Sketching 4-3A from the SOLIDWORKS 5; Maters <notspeciied
2021 folder. ] o HE ® o &
Create the 2D sketch. Ezlrg[;: Feature (Right Plane)
2. Right-click Right Plane from the FeatureManager. Go 305k (sketch]Sketch On Plane
Section View
3. Click Sketch. Comment
4. Display a Right view.
5. Sketch a circle at the origin as illustrated.

Create a Swept Boss feature.

6.

10.
11.

12.

Click Swept Boss/Base from the Features

CommandManager.
File Edit View Insert Tools Window »* @ - By M
Click the Circular Profile box. &
Swep&oss/Base
. . v\

Enter .10in for diameter. ! Suwept Bose/Base

. . . B Sweeps a closed profile along an open or closed path to
Cllck the 3D Sketch (path) mn the graphlcs @ create a solid feature. You can use options in the

. PropertyManager such as guide curves, profile
WlndOW. orientation options, and twist to create a wide variety of
Click OK. Path(3DSketch1)
View the results in the graphics P — L ®

window. = L}@

Close the SERSS
model. & sweep ®
v X
Profile and Path A

QO Sketch Profile
(® Circular Profile
c I 3DSketch1

Diameter (Enter a valu

@ [ioin

Options v
[ Thin Feature v
Curvature Display v
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Tutorial: 3D Sketching 4-4

Utilize the 3D Sketch placement method. Insert a hole on
a cylindrical face using the Hole Wizard.

1. Open 3D Sketching 4-4 from the SOLIDWORKS
2021 folder. Note: With a 3D sketch, press the Tab
key to move between planes.

2. Click the Hole Wizard & feature tool.

Create a Counterbore, ANSI Inch, Socket Head
Cap Screw fastener Type. Size - Y. Fit - Normal.
End Condition - Through All with a .100in Head
clearance.

4. Click the Positions Tab.

5. Click the 3D Sketch button. The Hole Position
PropertyManager is displayed. SOLIDWORKS

displays an active 3D interface with the Point XY «
tool.

w s

“¥" When the Point tool is active, wherever you click,
you will create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as illustrated.
The selected face is displayed in orange. This
indicates that an OnSurface sketch relation will be
created between the sketch point and the cylindrical
face. The hole is displayed in the model.

7. Insert a .25in dimension between the top face and the
sketch point.

Locate the point angularly around the cylinder. Apply
construction geometry.
8. Display the Temporary Axes.

Page 4 - 14
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©CBE RS

& Hole Specification @
v X

7T Type “ﬁ' Positions‘

Favorite v A
A

Standard:

ANSI Inch v

Type:

|Socket Head Cap Screw 87 ‘

Hole Specifications ~
Size:

i v
Fit:

|Norma| 7 ‘

[_] show custom sizing

End Condition ~
7 ‘Through All N7 ‘
Options A
Head clearance
- ‘ 0.10in .

[ ] Near side countersink
|:| Under head countersink
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9. Click the Line e Sketch tool. Note: 3D Sketch is still
activated.

10. Ctrl + Click the top flat face of the model. This moves the
red space handle origin to the selected face. This also
constrains any new sketch entities to the top flat face. Note

the mouse pointer ¥ « icon.

11. Move the mouse pointer near the center of the activated
top flat face as illustrated. View the small black circle. The
circle indicates that the end point of the line will pick up a
Coincident relation.

12. Click the center point of the circle.

13. Sketch a line so it picks up the AlongZ sketch relation.
The cursor displays the relation to be applied. This is a
very important step.

Deselect the Line Sketch tool.
14. Right-click Select.

15. Create an AlongY sketch relation between the || 2% | atong x
center point of the hole on the cylindrical face v | Along Y
and the endpoint of the sketched line. The ‘%
sketch is fully defined. Note: Add any A
additional relation if needed. r

16. Click OK ¢ from the PropertyManager.

Along Z

Coincident

Fix

17. Click OK ¥ to return to the Part
FeatureManager.

18. Expand the FeatureManager and view
the results. The two sketches are fully
defined. One sketch is the hole profile;
the other sketch is to define the
position of the feature.

sEBSe
N\

@ 3p Sketching 4-4 (Default< <Defaul
History
[@ sensors

» [A] Annotations

» [@Solid Bodies(1)

19. Close the model. [E)Equations
25 1060 Alloy

3 ! - [} Front Plane

¥ Create a second sketched line and insert an angle ?;?FL Plane
dimension between the two lines. This process is used to control | ; 527 ™"
the position of the center point of the hole on the cylindrical - @) Boss-Extrudef 1
face as illustrated. Insert an AlongY sketch relation between the L sketcht |

. . . (& CBORE for 1/4 Socket Head Cap

center point of the hole on the cylindrical face and the end point [ 30Sketcht
of the second control line. Control the hole’s position with an C Sketch?

angular dimension.
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The main advantage of the 3D Sketch placement method is that it can place a set of holes
on any set of solid faces, regardless of whether they are at different levels, or are non-

parallel. A limitation: 3D sketches can be fairly cumbersome and difficult. See section on
3D Sketching in SOLIDWORKS Help for additional details.

2D Sketching/Inserting Reference Planes

Reference Planes are geometry created from existing planes, faces,

vertices, surfaces, axes, and or sketch geometry. To access the
Plane PropertyManager, click Insert > Reference Geometry >
Plane from the Menu bar or click the Plane M tool from the
Consolidated Reference Geometry Features toolbar.

w1

* The dimensions of a bounding box can help you determine

the space required to ship and package product. Calculating a
bounding box for a part with many faces can be time consuming. If
a part has many faces, create the bounding box after you finish

modeling the part.

Plane Tool

The Plane ® tool uses the Plane PropertyManager. The Plane
PropertyManager provides the following selections:

o First Reference. Select a face, plane or
edge to create a reference plane. Options
are entity dependent:

e Reference Entities. Select the first
reference to define the plane. Based on
your selection, other constraint types
appear.

e Parallel. Create a plane parallel to the
selected plane. For example, select a
face for one reference and a point for
another reference. The software
creates a plane that is parallel to the
face and coincident to the point.

e Perpendicular. Create a plane
perpendicular to the selected

WYy

o Ay
Reference|Curves |nstant3D
Geometry
ﬁ Plane,

,”/ Axis %

}» Coordinate System
° Point

G Center of Mass
@ Bounding Box

dm Mate Reference

SERGQ| [oE B @ e
Plane @
i ’ Plane
v X~
Message A ¢ X =
Select references and Message ~
constraints Fully defined
First Reference
First Reference A
@ IVertex<1>
@ IFace<1>
. Colncldent
Project Parallel
. 0 Perpendicular
Second Reference Coincident
@ I 90deg
Third Reference ’0.10in ‘g
@ l— [ Flip offset
Options L)
A —
Flip normal
E‘ Mid Plane

reference. For example, select an edge or curve for one
reference and a point or vertex for another reference. The
plane is created perpendicular to the curve passing
through the point. Set origin on curve places the origin of
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the plane on the curve. When cleared, the origin is
placed on the vertex or point.

e Coincident. Create a plane that passes through the

selected reference. First Reference A
e Project. Project a singular entity such as a point, @ IVerTeX<1 >

vertex, origin, or coordinate system onto a non-planar. Coincident

Two options appear in the PropertyManager: 2] Project

e Nearest location on surface. Nearest location on su |

e Along sketch normal. O Along sketch normal

0

e Parallel to Screen. Create a plane at the selected

vertex that is parallel to the current view orientation.

SER S

e Tangent. Create a plane tangent to cylindrical, conical,

non-cylindrical, and non-planar faces. Select a surface il Plane @
and a sketch point on the surface. The plane is created Vv X
tangent to the surface and coincident to the sketch Message ~
pOil’lt. Select references and

e At Angle. Select a plane or planar face and select an constraints
edge, axis, or sketch line. You can specify the number First Reference ~
of planes to create. Enter the angle value in the angle Q IFace<1>

box. g Tangent
e Offset Distance. Create a plane parallel to a plane or Tangint Flip offset
face, offset by a specified distance. You can specify the

! Second Ref.
number of planes to create. Enter the Offset distance eeone Fererence ”
value in the distance box. Q l |
e Reverse direction. Reverse the direction of the Third Reference &

angle if required.
g qu | M Y |
e Numbers of Planes to Create. Display the selected 90.00deg
number of planes. At ahgle 50 S |
e Mid Plane. Create a [ Flip offset

mid-plane between
planar faces,
reference planes, and
3D sketch planes.
Select Mid Plane for
both references.

>

Second Reference

all
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Tutorial: Reference Plane 4-1 = 9
Create three Reference planes using the Offset Distance option from G ‘ ‘ . ‘ £ ‘ ﬂ
the Plane PropertyManager. B @
1. Create a New L part. Use the default ANSI Part template. Set VX
system units to MMGS. Hessage =
Fully defined
2. Display an Isometric view. First Reference ~
3. Right-click Top Plane from (7!
the FeatureManager design Parallel
tree. Perpendicular
4. Hold the Ctrl key down. Coincident
) 90.00deg ~
5. Click and drag the B oorm |2 i
boundary of the Top Plane S -
upwards in the Graphics ot
window. The Plane "';‘
PropertyManager is (=] via pane
displayed. Top Plane is displayed in the First Reference box. Second Reference ~
Release the Ctrl key and mouse pointer. el ]

A e B

Enter 25mm in the Distance. The Plane is offset by 25mm.

Enter 3 in the Number of planes to create box.

Click OK ¥ from the Plane PropertyManager. Planel, Plane2 and Plane3 are created
and displayed in the Graphics window. Each Plane is offset from the Top Plane a
distance of 25mm.

10. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled
Reference planes from an edge at a 45-degree angle.
1.

Open Reference Plane 4-2 from the SOLIDWORKS
2021 folder.

Click Right Plane from the FeatureManager design
tree.

Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

Click the At angle button.
Enter 45deg for Angle.

[
‘Boss-Extrude1
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6. Click the front vertical edge of Boss-Extrudel as
illustrated. Do not select the midpoint. Edge<1> is
displayed in the Selections box. The model is
fully defined. The arrow points downward.

7. Enter 2 in the Number of planes to create box.

8. Click OK ¥ from the Plane PropertyManager.
Planel and Plane2 are displayed in the
FeatureManager and in the Graphics window.

9. Close the model.

Tutorial: Reference Plane 4-3 R:“ Czwf |ns§30 S ‘ ‘ IS ‘ % ‘ @
Use the Plane PropertyManager to create a Geomety B Plane @
Reference plane using three vertices TESE : v X H
(Coincident) to the Extrudel feature. o e e Fully defined ~
1. Open Reference Plane 4-3 from the © point Firet Reference
SOLIDWORKS 2021 folder. ; o @
2. Click the Plane ¥ tool from the S [A] coincident
Consolidated Reference Geometry Fish st
Features toolbar. The Plane 7
PropertyManager is displayed. Sccond Referancs
3. Click three Vertices as illustrated. ) m
Vertex<1>, Vertex<2> and Vertex<3> . PRl coincdent
are displayed in the Reference Entities _
boxes. The model is [$] rje

. 0

Third Reference
. Coincident
Project

0

Options A

Flip normal
k v

fully defined. The arrow
direction is downward.

4. Click OK ¥ from the
Plane PropertyManager.
The angled Planel is
created and is displayed
in the FeatureManager
and the Graphics
window.

5. Close the model.

Fully define all sketches in the
model. However, there are times when
this is not practical, generally when
using the Spline tool to create a
complex freeform shape.
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Tutorial: Reference Plane 4-4

SOLIDWORKS® 2021 Reference Guide

Use the Plane PropertyManager to create a Reference plane
parallel to an existing plane, through a selected point.
1. Open Reference Planes 4-4 from the SOLIDWORKS 2021 -~

folder. Click the Plane M tool from the Consolidated
Reference Geometry Features toolbar. The Plane

PropertyManager is displayed.
2. Click the front top right vertex.

3. Click the Right Plane from the fly-out FeatureManager.

The model is fully defined.

4. Click OK ¢ from the Plane PropertyManager. Planel
is created and is displayed in the FeatureManager and

Graphics window. Close the model.

Wy
o <
Reference|Curves |nstant3D.
Geometry

V-
ﬁ Plane
7 [\
S AXis g
> Coordinate System
° Point
& Center of Mass
e Bounding Box

ﬂ] Mate Reference

Boss-Extrude

Parent/Child
Relationship

A Parent feature or sketch is an existing

feature or sketch on which others depend.
Example of a Parent feature: An Extruded
feature is the Parent feature to a fillet which

rounds the edges.

When you create a new feature or sketch

which is based on other features or sketches,

View  Insert Tools Window *

D FE &

I%Re

Screen Capture

Display
Modify
Lights and Cameras

Hide / Show

Toolbars

Workspace

Ctrl+R

i
[

User Interface L ' Feat
& Touch Mode \
}:l: Full Screen
. Mo
Customize Menu =
Zl Task

¥ | Mot

t
e
v
) g Pynamic Reference Visualization (Parent)
F11 = yhgmic Reference Visualization (Child)

ureManager Tree Area

Pane

ionManager

their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is
the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a feature
and a sketch from a component. If needed, Active Dynamic

Reference Visualization (Parent and Child).

1. Open the AirCylinder Linkage assembly from the

SOLIDWORKS 2021\Solutions folder.

2. Expand RodClevis<1> from the AirCylinder Linkage
assembly FeatureManager. Right-click Base-Extrude.

I_, Ori

@ ch

E Equations

85 Material <not spe
Lj Front
(7 Top
[J Right

gin

. B q

» Cut-Extrude3 <+—Sketch5 ————
= T
4 Cut-Extrude4 <—Sketch7 ———

amfer2 <—— I

» Cut-Extrude5 4—7v/

3. Click Parent/Child. The Parent/Child Relationships dialog box is displayed. View

the Sketch?2 relationships.

4. Click Close from the Parent/Child Relationships dialog box.
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View the Parent/Child Relationships for a feature. -

5. Right-click Sketch2 from Base-Extrude in the | TPenvenid felstonships - *
FeatureManager design tree. Erurs g
6. Click Parent/Child. View the Base-Extrude EZ‘T”_t &Y pose Extrude
rigin

feature relationships.

7. Click Close from the Parent/Child
Relationships dialog box.

8. Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status
bar at the bottom of the SOLIDWORKS window. There are five sketch states in
SOLIDWORKS:

w1
AT

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager
displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no
symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (orange-red). The
FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong
dialog box is displayed.

4. Invalid Solution Found. Y our sketch is solved but results in invalid geometry; for
example, a zero-length line, zero radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot be resolved, (brown).

SketchXpert is designed to assist in an over defined state of a sketch. SketchXpert
generates a list of causes for over defined sketches. The list is organized into Solution
Sets. This tool enables you to delete a solution set of over defined dimensions or
redundant relations without compromising your design intent.

w1

- - Auto-rotate view normal to sketch plane on sketch =

/Q\ Clle Options {6‘-} > SyStem DUse fully defined sketches i g M
Options > Sketch, and click the %)isplay arc centerpoints in part/assembly sketches G sketchXpert ©)
Use fully deﬁned sketches Opthl’l to Display entity points in part/assembly sketches v X
use fully defined sketches for z:;:t:k;j:ze::zhpm Pre Dragnose o soltons
Created featureS. to the sketch error.

Press "Manual Repair" to list all
the relations with errors.

Manual Repair

More Information/Options A

[] Always open this dialog
when sketch error occurs
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A Apply dimensions and relations calculated by the SOLIDWORKS application to
fully define sketches or selected sketch entities. Use the Fully Defined Sketch
PropertyManager.

- i Line

SketCh Entltles g E!'::I’ Ellipse é Corner Rectangle
Sketch entities provide the ability to create lines, x Zr::zda g Em EZC:::? ::ectang'e
rectangles, parallelograms, circles, etc. during NV spline < 3 Point Center Rectangle
the sketching process. To access the available ' Style Spline [ Parallelogram
sketch entities for SOLIDWORKS, click Tools | "'~ Straight Slot
» Sketch Entities from the Menu bar menu and ﬁ‘ Ezr:ttm priven curve gel,r;irtp::tsls:ia'ght e
select the required entity. This book does not g0 | centerline Centerpoint Arc Slot
over each individual Sketch entity in full detail ™\ Midpoint Line © Polygon
but will address the more advanced entities. A Text. © Ccircle
To obtain additional information of each sketch 2 z:::;zsr;:
entity, activate the sketch entity and click the @ Belt/Chain =) Tangent Arc

Customize Menu N 3 Point Arc

question mark @ icon located at the top of the

entity PropertyManager or click @ » Help @ from the Menu bar
and search by using one of the three available tabs: Contents,
Index, or Search.

Line Sketch Entity o BRe e
The Line Sketch entity >’ tool provides the ability to sketch /" Insert Line @
multiple 2D lines in a sketch. The Line Sketch entity uses the v X
Insert Line PropertyManager. The Insert Line oo ~
PropertyManager provides the following selections: Editkthtehsettingslf)f the next new line
e Orientation. The Orientation box options are: Orientation ~
e As sketched. Sketch a line in any direction using the g::kz Zt:;d

click and drag method. Using the click-click method, O Vertical

the As sketched option provides the ability to sketch a OAngle

line in any direction, and to continue sketching other Options A~

lines in any direction, until you double-click to end [ For construction

your process. [ infinite length

O Midpoint line

e Horizontal. Sketch a horizontal line until you release
your mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.
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e Options. The line type options are:

¢ For construction. Convert the selected sketch entity to
construction geometry.

e Infinite length. Create a line of infinite length which you

can later trim in the design process.

e Midpoint line. Create a line that is symmetrical from the

midpoint of the line.

e Parameters. Specify any appropriate combination of the

following parameters (or Additional Parameters) to define the
line if the line is not constrained by relations. When you change

Design Intent, Sketching and Sketch Entities

Orientation 2
O As sketched
@ Horizontal
O Vertical
O Angle
Options ~
|:| For construction
|:| Infinite length
] Midpoint line

Parameters 2

Nl N

|l“ 0.00°

one or more parameters, the other parameters update automatically.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry

that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.

Rectangle and Parallelogram Sketch
Entity

The Rectangle Sketch entity §’ tool provides the ability to
sketch a Corner Rectangle, Center Rectangle, 3 Point Corner
Rectangle, and a 3 Point Center Rectangle. The Parallelogram
Sketch entity provides the ability to sketch a Parallelogram.

The Rectangle and Parallelogram Sketch entity uses the
Consolidated Rectangle PropertyManager.

e Rectangle Type. The rectangle type options are:

e Corner Rectangle. Sketch a standard rectangle at a
corner point. Click to place the first corner of the
rectangle, drag, and release when the rectangle is the
correct size and shape.

e Center Rectangle. Sketch a rectangle at a center point.

Click to define the center. Drag to sketch the rectangle
with centerlines. Release to set the four edges.

e 3 Point Corner Rectangle. Sketch a rectangle at a
selected angle. Click to define the first corner. Drag,

rotate, and then release to set the length and angle of the
first edge. Click and drag to sketch the other three edges.

Release to set the four edges.
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[ Rectangle ®@
v
Rectangle Type A

Add construction lines
@ From Corners
O From Midpoints
Parameters A
*, 0.000
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0.000
o 0.000

0.000
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e 3 Point Center Rectangle. Sketch a rectangle with a center [ ~="" ~
point at a selected angle. Click to define the first corner. =
Drag and rotate to set one half the length of the centerlines. .
Click and drag to sketch the other three edges and 0 & O
centerlines. Release to set the four edges. %Add construction lines

@ From Corners

e Parallelogram. Sketch a standard parallelogram. A O fFrom Midpoints
Parallelogram is a rectangle whose sides are not horizontal = |parameters ~
or vertical with respect to the sketch grid. Click to define w0
the first corner. Drag, rotate, and then release to set the * 000
length and angle of the first edge. Click, rotate, and drag to * 000
set the angle and length of the other three edges. Release to ., | 000
set the four edges. ., |00

e Add construction lines. Convert the entities to construction M

geometry. « [
oy 000
¢ From Corners. Add centerlines from corner to corner.
e From Midpoints. Add centerlines from midpoint of line SERSS
slot ®
segments. .

o Parameters. Specify the appropriate combination of parameters ~ |settwees ~
to define the rectangle or parallelogram if they are not
constrained by relations. =y

Y (g
%dimensions
Slot Sketch Entity = #=3
\ Options A

The Slot Sketch entity + tool provides the ability to sketch a PmD‘Ftd —

Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a & 000mm

Centerpoint Arc Slot from the Consolidated Slot toolbar. &, 000mm

The Slot Sketch entity uses the Consolidated Slot PropertyManager. i :ZZZ:::

The Slot PropertyManager provides the -

following selections:

e Slot Type. The Slot type options are:

e Straight Slot. Sketch a three-point

slot. o o
! / g
e Centerpoint Straight Slot. . 5 . Y
Sketch a three-point slot located ] f / ]

at an Origin or centerpoint.

e 3 Point Arc Slot. Sketch an arc slot using three points
along the arc.

e Centerpoint Arc Slot. Sketch an arc slot using the
center point of the arc and the two end points.
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¢ Add dimensions. Insert dimensions as you sketch
the slot. R.51 2.87

e Center to Center. Insert center to center dimension
if the Add dimensions box is checked.

e Overall Length. Insert overall length if the Add
dimensions box is checked.

1% B

DAdd dimensions

e Parameters. Specify the appropriate combination of %ﬁ S s |
parameters to define slot if they are not constrained
by relations. The options are: Center X Somiet tn onte

Coordinate, Center Y Coordinate, Radius of Arc, parameters ~
Angle of Arc, Slot Width, Slot Length. @, [000mm

|:| For construction

0.00mm

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base
and Extruded Cut feature using the Instant3D tool.

1. Create a New | part. Use the default ANSI, IPS

0.0000Tmm

O
@ 0.00001mm
P=]
o

Part template. @ —\ . tlulue
2. Right-click Front Plane from the FeatureManager. — Straight Slot

Centerpoint Straight Slot

3. Click Sketch il from the Context toolbar. The Sketch @ 3 point Arc ot
toolbar iS dlsplayed Centerpoint Arc Slot

4. Click Centerpoint Straight Slot @ from the
Consolidated Slot toolbar as illustrated. The Slot

PropertyManager is displayed. If needed, uncheck the
Add dimension box.

5. Click the Origin. <
6. Click a position directly to the right of the ® )

Origin. e )i’ ,,,,,,,,,,,,, 7

7. Click a position directly above the second
point as illustrated.

Dimension the slot sketch. Origin

8. Right-click Smart Dimension & N
from the Context toolbar in the \
Graphics window. ( — J,_

9. Dimension the model as illustrated.

The sketch is fully defined. Note the
location of the Origin.

R.50
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Apply the Instant3D tool. Create an Extruded Boss/Base feature. The

Extruded Boss/Base feature adds material to a part. Note: Edit the ‘" U P
feature, and view the PropertyManager to confirm that you picked Reference Curves (jnstantaD
the correct dimension with the on-screen ruler. The Instant3D tool oeometry

does not provide various End Conditions for Design Intent.

Exit Sketchl.

10. Right-click Exit Sketch & Note: Instant3D
is active by default. If needed click Instant3D
from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base feature with a

default Blind End Condition.

12. Click the top edge as illustrated. A green
arrow is displayed. Drag the arrow forward
and click the on-screen ruler approximately
0.25in.

13. View Boss-Extrudel in the FeatureManager. Loz ~
14 Blind v
»

. Edit Boss-Extrudel in the FeatureManager.

15. Enter Depth = .30in. Click OK + from the I
PropertyManager. %.mm 5
Create an Extruded Cut feature using Instant3D. | =

16. Display a Front view.

Draft outward

17. Right-click the Front face. This is your Sketch plane.

18. Click Sketeh  from the Context toolbar. The Sketch toolbar
is displayed.

19. Click the Circle ©) Sketch tool.

20. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
21. Right-click Exit Sketch. Display an Isometric view.

Create an Extruded Cut feature.
22. Click the circumference of the sketch as illustrated.

23. Click and drag the arrow backwards to create a hole in the
model. Note: The default End Condition is Blind.

24. Release the mouse icon behind the model. The Cut-Extrudel
feature is displayed. View the model.

25. Close the model.
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Polygon Sketch Entity

The Polygon Sketch entity é\, tool provides the ability to create
equilateral polygons with any number of sides between 3 and 40.
The Polygon Sketch entity uses the Polygon PropertyManager.
The Polygon PropertyManager provides the following options:

o Existing Relations. Display information on existing relations
of the polygon sketch.

e Add Relation. Display the selected relations to the points and
lines of your polygon sketch.

¥ You cannot add a relation to a complete polygon.

You can only add a relation to the points and lines of

the polygon.
e Options. The option:

e For construction. Not selected by default.
Convert the selected sketch entity to
construction geometry.

e Parameters. Specify the appropriate combination
of parameters to define the polygon. When you
modify or change one or more parameters, the
other parameters update automatically. The
options are:

e Number of Sides. Set the number of sides in
your polygon.

e Inscribed circle. Selected by

SER S @

© Polygon ©)
v
Options A

l:‘ For construction

Parameters A

e I
@ Inscribed circle

O Circumscribed circle

& ‘o.oo
o ‘173,20508076
e ‘0.00°

New Polygon

csfc e ofc

inside the polygon. Define the size

default. Display an inscribed circle | j e
fnm

of the polygon. The circle is

X Polygon
construction geometry.

e Circumscribed circle. Displaya |-
circumscribed circle outside of the
polygon. Define the size of the fa
polygon. The circle is construction
geometry.

e Center X Coordinate. Display the
X coordinate for the center of your

Sketches a polygon. Click to place the center point, then
drag and release to size and orient the polygon. You can
pOlngH. ¢ change the number of sides after sketching the polygon.
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e Center Y Coordinate. Display the Y coordinate for

@ Inscribed circl
the center of your polygon. a2 el

O Circumscribed circle

e Circle Diameter. Display the diameter of the & ‘ 0.000 g

inscribed or circumscribed circle. N -
e Angle. Display the angle of rotation. o ‘ > 69953423 -
e New Polygon. Create more than a single polygon i oo -

without leaving the PropertyManager.

ZNew Polygon

Tutorial: Polygon 4-1
Create a new part using the Polygon Sketch entity.
1. Create a New L] part. Use the default ANSI Part template.

2. Right-click Top Plane from the FeatureManager design L
tree. This is your Sketch plane.

A
3. Click Sketch  from the Context toolbar. The Top Plane
boundary is displayed in the Top view.
4. Click the Circle & Sketch tool. The Circle
PropertyManager is displayed. @ Y
5. Sketch a circle centered at the origin. u pi?,}g; o -
Insert a polygon. ]
6. Click Tools > Sketch Entities > Polygon
from the Menu bar or click Polygon from the 5
Sketch toolbar. The Polygon PropertyManager
is displayed.
7. Sketch a POlygon centered at the Orlgll’l larger Sketches a polygon. Click to place the center point, then
. : drag and release to size and orient the polygon. You can
than the CerIG as llluStrated' o chaige the numbter of sides after ;ktetdrl)ingezhe pYolygon.

8. Click OK ¥ from the Polygon
PropertyManager.

9. Rebuild 9 the model. View the created Polygon in
the Graphics window.

10. Close the model.

w 1

¥* For illustration purposes, the Reference planes and
grid are hidden. Sketch Relations are displayed.
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Circle Sketch and Perimeter (@ ER ¢ 01

HE\@\@

Circle Sketch Entity O cret O Cire
The Circle Sketch and Perimeter Circle e : » ;: e Type “
Sketch entity & tool provides the ability to @ z Ds
control the various properties of a circle. T"ﬂ@ = —— —
The Circle Sketch and Perimeter Circle . . ET
Sketch entity uses the consolidated Circle » Ruldefd A1 _
PropertyManager. The consolidated Circle o€ rix . Under Defined
PropertyManager provides the following Broae ~ %’?'am"s -
Opti ons: [ For construction X
Parameters ~| | Options 2
e Circle Type. Select either a center-based Q % : BT
circle or a perimeter-based circle sketch e o | |Faremeters 7
. /‘ [333.14980255| (Ge .
o ; :
o [Existing Relations. The Existing Vo lli0.11515525 .
Relations box provides the following
option: —
- & \§ @
e Relations. Display the automatic _S%de’\ " Comort Offent
relations inferenced during sketching ¢
or created manually with the Add e
Relations tool. The callout in the Graphics i
window is highlighted when you select a I
relation in the dialog box. The Information
icon in the Existing Relations box displays pt
the sketch status of the selected sketch entity. frl::;cgf:gaacni;clilecali:: tts g;;eet::;;f of the circle,

Example: Under Defined, Fully Defined, etc.

e Add Relations. Add relations to the selected entity. Display
the relations which are possible for the selected entity.

e Options. For construction. Not selected by default. Convert the selected entity to
construction geometry.

e Parameters. Specify the appropriate combination of parameters to define the circle if
the circle is not constrained by relations. The options are:

e Center X Coordinate. Set the Center X Coordinate value.
e Center Y Coordinate. Set the Center Y Coordinate value.

e Radius. Set the Radius value.
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The Perimeter Circle Sketch entity provides the ability to define a circle using 3 points
along its perimeter. This sketch entity is very useful when you are not concerned about
the location of the center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.
1. Create a New [ part. Use the default ANSI Part template.

2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane. T__

3. Click Sketch i from the Context toolbar.

4. Click the Line e Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines. @ 'FL[U - i @

6. Click Perimeter Circle from the Consolidated Circle O an ' 1
Sketch toolbar. The Circle PropertyManager is \ab e _ d
displayed. \;/Perlmeter grcle

7. Click each line once.

8. Click a position as illustrated to determine the size
of the circle. The X coordinate, Y coordinate, and
Radius are displayed in the Parameters box. The
two lines are tangent to the circle. You created a
simple circle using the Perimeter Circle sketch
entity. o &

%

9. Click OK ¥ from the Circle PropertyManager.
View the model. B

10. Rebuild 9 the model.
11. Close the model.

w1

‘¥ If the two lines change, the circle remains tangent
to the lines.

w s

“¥" In System Options, under the Sketch folder,
apply the GhOSt image on drag OptiOl’l. The OptiOl’l Enable spline tangency and curvature handles
displays a ghost image of a sketch entity’s original  |[]show spline control polygon by default
position while you drag the sketch in the Graphics %Ghost image on drag

window.

Line length measured between virtual sharps in 3d

Show curvature comb bounding curve
Scale sketch on first dimension creation

[ Enable on screen numeric input on entity creation
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Centerpoint Arc Sketch Entit -
P Y @ Ee@ [SER®@
N Arc N Arc
The Centerpoint Arc Sketch entity & tool » * v )
provides the ability to create an arc from a p— A | aretype A
center point, a start point, and an end point. The |is ;3; o T E\:
Centerpoint Arc Sketch entity uses the _D 12 — _’D 1
consolidated Arc PropertyManager. P(Eggggml N[
The Arc PropertyManager controls the & B ‘
properties of a sketched Centerpoint Arc, o) — Rl:::;::ﬂ"ed 1
Tangent Arc, and 3 Point Arc. o 1 &
. (3 000 : N
The consolidated Arc PropertyManager Options .
. . . ('; 0.00 [JFor construction
provides the following options: e — Parameters A
. (? 49.31429212
e Arc Type. Select a Centerpoint Arc, . ’
. . (\ -18.75396816
Tangent Arc, or 3 Point Arc sketch entity.
o Existing Relations. The Existing Relations G 38439071 \
box provides the following option: (3 |4293337637
. . . ("' -32.94517748
e Relations. Display the automatic relations < 5559772
inferenced during sketching or created mgnually p W‘ .
with the Add Relations tool. The callout in the

Graphics window is highlighted when you select

a relation in the dialog box. The Information icon

in the Existing Relations box displays the sketch

status of the selected sketch entity. Example: / @ U-i @
=3+,

Under Defined, Fully Defined, etc. 1 3 fL@ A 2
e Add Relations. Add relations to the selected entity. Q Cénterpoint Arc
Display the relations which are possible for the v TEvan ) Tangent Arc ,
selected entity. , M 3 Point Arc

e Options. For construction. Convert the selected
entity to construction geometry.

o Parameters. Specify any appropriate combination of parameters
to define your arc if the arc is not constrained by relations.

e The options are: Center X Coordinate, Center Y
Coordinate, Start X Coordinate, Start Y Coordinate,
End X Coordinate, End Y Coordinate, Radius, and
Angle.
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Tutorial: Centerpoint Arc 4-1

Create a Centerpoint Arc sketch.

1. Create a New LJ part. Use the default
ANSI Part template. é
|

2. Right-click Front Plane from the &
FeatureManager. This is your Sketch RO
plane. Click Sketch € from the
Context toolbar. Click the Line 7

Sketch tool. Sketch a horizontal line
through the origin as illustrated.

3. Click Centerpoint Arc ** from the
Consolidated Arc Sketch toolbar. The
Arc icon is displayed on your mouse
pointer. Click a location on the
horizontal line left of the origin. Do
not pick the origin or the endpoint.

4. Click a position to the right and up on
the horizontal line.

5. Drag to set the angle and the radius of the arc. Release the
mouse button to place the arc. View the Arc PropertyManager
and the coordinates.

6. Click OK ¥ from the Arc PropertyManager. Close the

model. —
S ERG@
N Arc
Tangent Arc Sketch Entity v ’
Arc Type A
The Tangent Arc Sketch entity § tool provides the ability to v [T {g\
create an arc, which is tangent to a sketch entity. The Tangent Arc : (I
Sketch entity uses the Arc PropertyManager. View the Parameters 75 gent Arc
Centerpoint Arc Sketch entity section above for additional 00
information on the Arc PropertyManager. o
.y G 0.00
“¥* You can transition from sketching a line to sketching a ¢ .
Tangent Arc, and vice versa without selecting the Arc tool from G -
the Sketch toolbar. Example: Create a line. Click the endpoint of | &+ %
the line. Move your mouse pointer away. The Preview displays R 00
another line. Move your mouse pointer back to the selected line .
endpoint. The Preview displays a tangent arc. Click to place the

arc. Move the mouse pointer away from the arc endpoint. Perform
the same procedure above to continue.
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Tutorial: Tangent Arc 4-1

Create a Tangent Arc sketch. & ‘ ‘ B ‘ & ‘ m >
1. Create a New | ] part. Use the default ANSI Part T
template. & Part4 (Default< <Default>_Display
[@Histo
2. Right-click Front Plane from the FeatureManager. ;'e:sgs
Click Sketch C_ from the Context toolbar. ' Anmt_ations
Equations
. . gi Material ® L
4. Click the Line ¢ Sketch tool. M 2 |
5. Sketch a horizontal line through the Origin. () Top Pla %Mlm"t )
m Right Pl; 0 3D S.ketch. On Plane
6. Click Tangent Arc =) from the Consolidated Arc L, Origin zgcmn View
Sketch toolbar. The Arc icon is displayed on the omment
mouse pointer.
7. Click the left end point of the
horizontal line.
8. Drag the mouse pointer upward %
and to the left for the desired
shape. T 5
9. Click an end point. You created a ‘R HE

Tangent Arc. The Arc
PropertyManager is displayed.

10. Right-click Select in the Graphics window to deselect the Sketch tool. Click OK o
from the Arc PropertyManager.

11. Exit the sketch. Close the model.

w1

‘¥* You can select an end point of a line, ellipse, arc or a spline. The Tangent Arc tool
creates both Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity & tool provides the ability to create an arc by specifying
three points: a starting point, an endpoint, and a midpoint.

View the Centerpoint Arc Sketch entity section for additional

information on the Arc PropertyManager.

Tutorial: 3 Point Arc 4-1

Create a 3Point Arc sketch. f @ (U~ % {

1. Open 3 Point Arc 4-1 from the SOLIDWORKS 2021 RO - A Tim
folder. r Q @nterpoint Arc

2. Edit Sketchl. Click 3 Point Arc ¢ from the 2~ ). Tangent Arc
Consolidated Arc Sketch toolbar. Ll /™~ 3 Point Arc
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3. Click the top point of the vertical line for the start point as
illustrated.

4. Click the right point of the open circle for the end point as
illustrated.

5. Drag the arc downward to set the radius.

6. Click a position for the midpoint of the b
3Point Arec. -

7. Click OK ¥ from the Arc /8
PropertyManager.

8. Close the model. "=

Ellipse Sketch Entity =

The Ellipse Sketch entity } tool provides the ability to create a
complete ellipse. The Ellipse PropertyManager controls the
properties of a sketched Ellipse or a Partial Ellipse. The Ellipse
PropertyManager provides the following selections:

Existing Relations. The Existing Relations box provides the
following option:

e Relations. Display the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Add relations to the selected entity. Display
the relations which are possible for the selected entity.

Options. The Options box provides the following option:

SOLIDWORKS® 2021 Reference Guide

LRY -
n»
SERSG@
O] Ellipse ®@
v
Existing Relations A
L

®  Under Defined
Add Relations
X [Fix

Options
|:| For construction

Parameters

a -1.28473116 :
@ 0.278814 :
¢ :
s :

e For construction. Convert the selected entity to construction geometry.

Parameters. Specify any appropriate combination of parameters to define the ellipse
if the ellipse is not constrained by relations. The available options are: Center X
Coordinate, Center Y Coordinate, Start X Coordinate (only available for a Partial
Ellipse), Start Y Coordinate (only available for a Partial Ellipse), End X
Coordinate (only available for a Partial Ellipse), End Y Coordinate (only available
for a Partial Ellipse), Radius 1, Radius 2, and Angle (only available for a Partial

Ellipse).
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Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New | part. Use the A O
default ANSI Part template. < FR‘A Convert
2. Right-click Front Plane from the ::jﬂhpse
FeatureManager. This is your \J Parabola
Sketch plane. N\ Conic

3. Click Sketch C_ from the Context
toolbar.

4. Click the Ellipse & Sketch tool. The Ellipse icon
is displayed on the mouse pointer.

5. Click the origin in the Graphics window. This is
the start location.

6. Drag and click to set the major axis of the
ellipse. The ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the
ellipse.

Deselect the sketch tool.
8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.
9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom
vertical point of the Ellipse.

11. Right-click Make Vertical from the Pop-up
menu.

12. View the sketch.
13. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity } tool provides the ability
to create a partial ellipse or an elliptical arc from a
centerpoint, a start point, and an end point. You used a
similar procedure when you created a Centerpoint Arc. The
Ellipse PropertyManager controls the properties of a
sketched Ellipse or a Partial Ellipse. View the Ellipse
section for additional information on the Ellipse
PropertyManager.
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Parabola Sketch Entity S

RS &

U Parabola @
The Parabola Sketch entity §’ tool provides the ability to create |

a parabolic curve. The Parabola Sketch entity uses the Parabola | esting relations ~
PropertyManager. The Parabola PropertyManager provides the L
following selections:

®  Under Defined

e Existing Relations. The Existing Relations box provides the

Add Relations A
following option: | Fix
Options A

e Relations. Display the automatic relations inferenced

|:| For construction

during sketching or created manually with the Add

1.3175328

e Add Relations. Add relations to the selected entity. Display i~
: : ; : L
the relations which are possible for the selected entity.

N ‘ 213757396
Y

Parameters A
Relations tool. The callout in the Graphics window is [x | 362630399 :
highlighted when you select a relation in the dialog box. | /3 158914994 :
The Information icon in the Existing Relations box [} | 492869409 :
displays the sketch status of the selected sketch entity. [y 224049679 :
Example: Under Defined, Fully Defined, etc. [ |-471250322 "

e Options. For construction. Not selected by default. Convert
the selected entity to construction geometry.

e Parameters. Specify the appropriate combination of
parameters to define the parabola if the parabola is not
constrained by relations. The available options are: Start X
Coordinate, Start Y Coordinate, End X Coordinate, End
Y Coordinate, Center X Coordinate, Center Y
Coordinate, Apex X Coordinate, and Apex Y Coordinate.

Tutorial: Parabola 4-1

Create a Parabola sketch. (V- g
1. Create a New | ] part. Use the default ANSI, IPS 0, m ‘5"1‘.1’.“
Part template. (=) Ellipse
2. Right-click Front Plane from the FeatureManager. \c Fantfel [l
This is your Sketch plane. U Parabola
3. Click Sketch {_ from the Context toolbar. [\ Conic

Apply the Parabola Sketch tool.

4. Click the Parabola \J Sketch tool from the
Consolidated Sketch toolbar. The Parabola icon is
displayed on the mouse pointer.
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5. Click a position in the Graphics window to locate
the focus of your parabola.

6. Drag to enlarge the parabola. The parabola is

outlined.

7. Click on the parabola and drag to define the & / L
extent of the curve. The Parabola PropertyManager '
is displayed.

8. Click OK ¥ from the Parabola PropertyManager.
9. Close the model.

Conic Sketch Entity GERG@ || SERSG@

N\ Conic @ | | N conic @
The Conic Sketch entity % tool provides v
the ability to sketch conic curves driven by  |options A | |Pristing Relations .
endpoints and Rho value. Depending on the g;"ic‘z”mdi"” b

. uto tangency

Rho value, the curve can be elliptical, ® Under Defined
parabolic, or hyperbolic. In previous versions of the Add Relations ~
SOLIDWORKS software, you could sketch ellipses and parabolas. | & ix
However, you could not sketch ellipses or parabolas by their s _ ~
endpoints, so it was difficult to make them tangent to existing Parametz == v
geometry.

Conic curves can reference existing sketch or model geometry, or

they can be standalone entities. You can dimension the curve with a driving dimension,
and the resulting dimension displays the Rho value. The conic entity also includes a value
for the radius of curvature.

£0.32
po.32

Conic curve sketch that references existing geometry Preview of revolved sketch

Finished model
|

“¥ Auto Tangency accelerates the process of sketching a conic curve.

When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of

the curve.
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The Conic Sketch entity uses the Conic PropertyManager. The @ Blele™
Conic PropertyManager provides the following selections: 1\ Conic @
o Existing Relations. The Existing Relations box provides the |+

fOHOWing Option: Existing Relations ~

e Relations. Display the automatic relations inferenced b
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.

@ Under Defined

The Information icon in the Existing Relations box R:i:(ations "
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc. °'“i°l“__’|F " ~
e Add Relations. Add relations to the selected entity. Display Parameters ~
the relations which are possible for the selected entity. [ [ 6227850128 s
e Options. The Options box provides the following selection: {5 | 226799828 :
e For construction. Not selected by default. Convert the i v
- - Qe
selected entity to construction geometry. v
. e combinat S
o Parameters. Specify the appropriate combination of X
parameters to define the parabola if the parabola is not s v
constrained by relations. The options are: Start X x :
Coordinate, Start Y Coordinate, End X Coordinate, End A °
Y Coordinate, Center X Coordinate, Center Y p .
Coordinate, Apex X Coordinate, and Apex Y Coordinate. ”
< :
Tutorial: Conic 4-1 —
- AR Vg
Create a Conic sketch. m R
1. Open Conic 4-1 from the o < -
SOLIDWORKS 2021 folder. The model we
. . { C: Partial Ellipse
contains an arc and spline. ~J U purabo
Apply the Conic Sketch tool. Conic
2. Click the Conic "V Sketch tool from the
Consolidated Sketch toolbar. The Conic
icon is displayed on the mouse pointer. & \
. . . ,__-r--'-‘_'___-——_—__——_'—‘_‘-*——,_.e .
3. Click the first endpoint for the conic m
. Vs
curve as illustrated. :
Origin

/
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4. Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached W}_Fr_.——!—_._i_‘
to the existing arc sketch, a yellow inferencing BN
line is displayed.

5. Click the second endpoint as illustrated.

inferencing line is displayed tangent to the L

6. Drag the mouse pointer upwards. A yellow l
spline sketch.

7. Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

8. Click at the intersection of both inferencing — = —— N
lines to set the top vertex of the conic curve. A
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

9. Drag the pointer to the left until the Rho l
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

10. Click to set the Rho value to 0.75. Reference
points are displayed for the curve's shoulder
and top vertex. Tangent relations are created
between the curve and the original sketches.

11. Click OK ¥ from the Conic
PropertyManager.

12. Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
midline curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic and translates into
the squareness of the surface. In theory at 1.0 it is

a dead sharp corner, 0.8 is a very modern squarish
corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse
section that tends toward a line between the end
points.
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Spline Sketch Entity SERS@ |SERS@

(U spline ®@ (U spline ©)
The Spline Sketch entity »’ tool provides v
the ability to create a profile that utilizes a | Parameters & E"Jl""“'-‘ Relations e
complex curve. This complex curve is M
called a Spline (Non-uniform Rational B- Ay (1985832t S
Spline or NURB). (15842168 Add Relations ~
0.000 3
Create a spline with control points. With ; — (]
: : . : Options A
spline control points, you can: oo [ For construction

N

e Use spline points as handles to pull the . 0000 Di:tfw e
. . . alr?talp internal
spline into the shape you want. £ oo continuity
- . Parameters A
e Add dimensions between spline points Tl i

or between spline points and other feserinEtendie Y
entities. Reset All Handles N

Relax Spline

<> <> <>

e Add relations to spline points. _ -
Rigportiendl ¢ 407371854
The 2D Spline Prop.ertyManager provides ¢ R
the following selections: [Jangent cving
o Existing Relations. The Existing Relations box provides the ResetThis Handle
following option: Reset All Handles
e Relations. Display the automatic relations inferenced ,_\Dien':sflmle .
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.
e Add Relations. Add relations to the selected entity.
Display the relations which are possible for the - [U 'Fk’ @
selected entity. Y S%\?n
e Options. The Options box provides the following /Y Style Spline
selections: | & Spline on Surface
\/\ . .
¢ For construction. Not selected by default. P% Fquation Driven Curve
Convert the selected entity to construction
geometry.

e Show Curvature. Not selected by default.
Control the Scale and Density of the curvature.
Display the Curvature of the spline in the
Graphics window.
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Maintain Internal Continuity. Selected by default. Maintain the spline's internal
curvature. When Maintain Internal Continuity is cleared, the curvature scales
down abruptly.

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

Parameters. Specify the appropriate combination of parameters. The available

parameters are:

Spline Point Number. Highlight your selected spline point in the Graphics
window.

X Coordinate. Specify the x coordinate of your spline point.
Y Coordinate. Specify the y coordinate of your spline point.

Radius of Curvature. Control the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Display the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weightingl. Control the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Control the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Control the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y, or Z axis.
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e Tangent Polar Direction. Control the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

e Tangent Driving. Enable spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

¢ Reset This Handle. Return the selected spline handle to the initial state.
¢ Reset All Handles. Return the spline handles to their initial state.

¢ Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If the node you are dragging
results in a spline which is not smooth, re-select the spline to display the
PropertyManager. Click the Relax Spline selection under the Parameters option.
This will re-parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar Spline Tools
Use the tools located on the Spline toolbar to ?’ *;6 /f_ }.-".I_.“; L_ HE% O\ ﬂ

control properties of a sketched spline. The
Spline toolbar provides the following tools:

s
e Add Tangency Control. The Add Tangency Control tool 7
adds a tangency control handle. Drag the control handle along
the spline and position it to control the tangency at the selected
point.

e Add Curvature Control. The Add Curvature Control tool 0
adds a curvature control handle. Drag the control handle along
the spline and position the control handle to control the spline
shape at the selected point.

e Insert Spline Point. The Insert Spline Point tool r adds a
point to the spline. Drag spline points to reshape the spline.

n s
P

You can insert dimensions between the spline points.

o  Simplify Spline. The Simplify Spline tool 7= reduces the
number of points in the spline. This function improves the
performance in the model for complex spline curves.

e Fit Spline. The Fit Spline tool - adds a spline based on the
selected sketch entities and edges.
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Show Spline Handles. The Show Spline Handles tool el displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

Show Inflection Points. The Show Inflection Points tool R displays all points where
the concavity of a selected spline changes.

Show Minimum Radius. The Show Minimum Radius tool /) displays the
measurement of the smallest radius in the selected spline.

e Show Curvature Combs. The Show Curvature U FLKH d;
Combs tool & displays the scalable curvature o @
combs which visually enhance the curves of your r (U Sﬁ
selected spline. A/ Style Spline

| & Spline on Surface

Tutorial: 2D Spline 4-1 % Equation Driven Curve

Create a 2D Spline sketch. ]

1. Create a New | part. Use the default ANSI, IPS
Part template.

2. Right-click Right Plane from the FeatureManager.

This is your Sketch plane.

3. Click Sketch & from the Context toolbar.

Apply the Spline Sketch tool.

4. Click the Spline U Sketch tool. The spline icon is
displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

6. Right-click Select on the last control point. l.

7. Exit the Spline [V tool.

8. Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape. <

9. Click OK ¥ from the Spline PropertyManager.

10. View the results.
11. Close the model.

Page 4 - 43



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2021 Reference Guide

AR Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles (e tool from the Spline toolbar or click Tools > Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline sketch handle.
1. Open 2D Spline 4-2 from the SOLIDWORKS 2021 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to
dimension a spline handle. Display the
handles.

3. Click the Spline in the Graphics
window. The Spline
PropertyManager is displayed.
Locate the pointer on the top

handle. The rotate & icon is
displayed.

4. Click the top handle tip.

5. Rotate the handle upwards as
illustrated to create a Tangent
Driving.

6. Right-click Smart Dimension € from the &
Context toolbar.

Create a Tangent Radial dimension.
7. Click the handle arrow tip.

8. Click the horizontal line.
9. Enter 40deg.

10. Set precision to none.

Modify

\/)()'*ﬂg,

D1 1

Angle
40deg -
N

Units

11. Click OK % from the Dimension
PropertyManager. View the results.

12. Close the model.

EE
w1
“¥" For a Tangent Magnitude, select the arrow
tip on the handle to add the dimension. Tolerance/Precision ~
Oy 130, [None 'I
“¥" Tllustrations may vary depending on
SOLIDWORKS version and system setup. o[22 Document) v
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Tutorial: 3D Spline 4-1
Create a 3D Spline Sketch.

1. Create a New | part. Use the default ANSI Part

template.
2. Click Insert > 3D Sketch from the Menu bar menu. — L
Apply the Spline Sketch tool. m

3. Click the Spline /V Sketch tool.

4. Click a location in the Graphics window to

place the first spline point. Each time you
click a different location, the space handle
is displayed to help you sketch on a
different plane. N
v ¥~

¥ Press the Tab key to change planes in a
3D Sketch.

5. Click three additional locations as

illustrated. The Spline PropertyManager is

displayed.
6. Right-click Select on the last control point. L
7. Exit the 3D Sketch. 3DSketchl is created /

and displayed in the FeatureManager. First point
8. Close the sketch.

Last point
Tutorial: 3D Spline 4-2
Edit a 3D spline sketch using the current elements.
1. Open 3D Spline 4-2 from the SOLIDWORKS
2021 folder.

2. Edit 3DSketchl.

3. Click the Spline in the Graphics window. The / *
Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline.

Modify the Spline shape using the click and drag
method on a handle.
7. Click a spline handle as illustrated.

8. Drag the selected spline handle to control the
tangency vector by modifying the spline’s
degree of curvature at the spline point. The
Spline PropertyManager is displayed.

Reset the handle to the original location.

9. Click the Reset This Handle option. All values
relative to the selected handle return to their
original value.

Move the spline.

10. Click and drag the spline from left to right. Do
not select a control point. As the spline is
moved, it retains its shape.

11. Click OK ¢ from the Spline
PropertyManager.

12. Exit the 3D Sketch. View the results.
13. Close the model.

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the
SOLIDWORKS 2021 folder.

2. Edit 3DSketchl.

3. Click the spline from the Graphics
window. The Spline PropertyManager is
displayed.

SOLIDWORKS® 2021 Reference Guide

Parameters

o, 400 i
s, 3000 i
s, 500] i

%_,
L

[#] Tangent Driving

Reset This Handle
Reset All Handles

Relax Spline

Proportional

4. Click the Add Tangency Control 7 tool
from the Spline toolbar.

Spline Tools

vior LB A o
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5. Drag to place the handle as illustrated.
6. Click a position for the handle.

7. Click OK ¥ from the Spline

PropertyManager.
8. Exit the 3D Sketch. View the results.
9. Close the model. L
=
Style Spline

The Style Spline >‘ tool provides the ability

to sketch single-span Bézier curves. These curves
let you create smooth and robust surfaces, and
are available in 2D and 3D sketches.

The Style Spline consists of only one span. You
shape its curvature by selecting and dragging
control vertex points. Sketch entities connect the
control vertices which form the control polygon
of the curve.

With the Style Spline tool, you can control the degree and
continuity of the curves. You can inference style splines
for tangency or equal curvature. You can constrain the
points and dimension the curves' sides. These curves also
support mirroring and self-symmetry.

Spline on Surface Entity

The Spline on Surface entity @ tool provides the
ability to sketch splines on various surfaces.
Splines sketched on surfaces include standard
spline attributes, as well as the capabilities to add
and drag points along the surface and to generate a
preview that is automatically smoothed through the
points.

i

Al spline points are bounded to the surface on
which they are sketched.
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Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature. S e el Wil -

1. Open Spline on Surface 4-1 from the ~< nJ I @ q

SOLIDWORKS 2021 folder. & pline on surface !t of
CHTTTES BN S d
2. Click the top left face as illustrated. <ol

3. Click the Spline on Surface € Sketch tool. The
spline icon is displayed on the mouse pointer.

4. Create a five-point closed spline as illustrated.

5. Click OK ¥ from Spline PropertyManager to
close the sketch tool.

6. Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is displayed.

7. Click the left vertical line as illustrated for
Direction 1. Edge<1> is displayed in the
Direction of Extrusion box.

8. Enter 10mm for Depth. K|

9. Click OK % from the Boss-Extrude

PropertyManager. Boss-Extrudel is displayed.
View the results in the Graphics window.

10. Close the model.

Splines on surfaces can:

e Span multiple faces. S E RS
@ Boss-Extrude1 @
e Update if model geometry is updated |+ x ®
(unless the splines are constrained). From ~
Sketch Plane v
3 5 5 Direction 1 A =
e Move points on the sphnp to different %) o § BEENE @ >
faces by dragging the points but not W <
by dragging the curve itself. I - € spline on Surface 4-1 (Default<
G 10.00mm epth (Entel aA\a u Hlstory
Merge result Sensors
E }i‘ » [A] Annotations
Draft outward » [@Solid Bodies(1)
[ pirection 2 v [E)Equations
Selected Contours v Ei Material <not specified>
[ Front Plane
0 Top Plane
[J Right Plane
I_.Origin
~ @] Extrude-Thin1
CSketch1
k (30 (-) 3DSketch1
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Intelligence Modeling - SEESOFT § E B S@
Equation Driven Curve P (e
The Equation Driven Curve “7% tool is a 2D i et siprubd [ S ————
Sketch spline driven by an equation. This end parameter 2 e e
Sketch entity provides the ability to create a B 7| [endveluese:

curve by specifying the equations that define @ parametic “'”“‘%"Egﬁ; ~
the curve. You can use any function that is Parameters 2 O Parametric
supported in the Equations dialog box. See eqm P ~
Chapter 18 - Intelligence modeling techniques | ,, O Ejtm
for additional information. Parameters Parameters

The Equation Driven Curve entity uses the : E ‘ : 22
Equation Driven Curve PropertyManager. The P ]

PropertyManager provides the following selections:
o Equation Type. Available types: Explicit (selected by default) and Parametric.

e Explicit. Define X values for the start and endpoints of the range. Y values are
calculated along the range of X values.

e Parametric. Define T values for the start and endpoints of the range. You can
define an equation for X values and another equation for Y values. Both equations
are solved along the range of T values. Only parametric curves are available in 3D
sketches.

o Parameters. The Parameters box provides the following options:

e Equation. Enter an equation as a function of X-. If you enter an equation that
can’t be resolved, the text color is displayed in red.

e Parameters. Enter the start and end X value of the equation.
e Transform. Enter the translation of X-, Y- and angle for the curve.
Tutorial: Equation Driven Curve 4-1

Create an Equation Driven Curve on the Front Plane.
1. Create a New L part. Use the default ANSI, IPS Part template.

Create a 2D Sketch on the Front Plane.
2. Right-click Front Plane from the FeatureManager.

3. Click Sketch E from the Context toolbar. The
Sketch toolbar is displayed. Front Plane is your it View Insert Tools Window # {3} ||

Sketch plane. b % ¥ o C
n ine

4. Click the Equation Driven Curve % Sketch tool. \\?\' ,
The Equation Driven Curve PropertyManager is D % :;ylz;::r;iven Curve
displayed. This tool provides the ability to build | MBD Dimensions | SOLIDWORKS Add-Ins
intelligences into a part.

‘
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Specify the equation that defines the sketch. Note: y- is a function

of x-. GO BER o @
5. Click Explicit for Equation Type. ' Equation Driven C... (2
v X
6. Enter 3*x*sin(x) as illustrated in the Equation Message -
box. n -
Equation Type [a
7. Enter 0 for the start point as illustrated. gEXP"C“
Parametric
8. Enter 4*pi for the end point. Note: You can fix barameters ~
the end points of the curve by applying the Fix 1 e
tOOl. Yx | 3%*sin(x) ‘
9. Click OK ¥ from Equation Driven Curve perameters
PropertyManager. View the created curve. * D
Note: click the curve in the Graphics window to 0 il
edit the Parameters of the curve. H

10. Click Exit Sketch. View the results.
11. Close the model.

w1

“¥* Use regular mathematical notation and order of operations to write an equation. x;
and x» are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in X-, y- or rotation. To specify x=f(y)
instead of y = f(x), use a 90-degree transform.

w 1

‘¥ View the .mp4 provided movies in the book to better understand the potential of the
Equation Driven Curve tool. The first one is Calculating Area of a region bounded by
two curves (secx)”2 and sin x in SOLIDWORKS; the second one is Determine the
Volume of a Function Revolved Around the

x Axis in SOLIDWORKS. Both are located

in the SOLIDWORKS 2021 folder.

Curve Through XYZ Points

The Curve Through XYZ Points & feature
provides the ability to either type in (using | Curve File X
the Curve File dialog box) or click Browse ‘
and import a text file using x-, y-, z-

. . Point X Y| Z
coordinates for points on a curve. Save

Browse...

A text file can be generated by any Save As
program which creates columns of

Insert

numbers. The Curve [2) feature reacts like
a default spline that is fully defined. oK

Cancel
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Create a curve using the Curve Through XYZ Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

“¥" Tt is highly recommended that you insert a few extra points on either end of the
curve to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data: x-, y-, z-, must be separated by a space, a comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ
Points tool. Import x-, y-, z- data from a CAM
program. Verify that the first and last points in
the curve file are the same for a closed profile.

1.

Open Curve Through XYZ points 4-1
from the SOLIDWORKS 2021 folder.

.{@} .

Curve Through X

5

i

U

Reference |Curves| Instant3D

Geometry

ey

U Curve Through XYZ Points
@ Helix and Spiral

Click the Curve Through XYZ Points & tool
from the Features CommandManager. The Curve

File dialog box is displayed.

Import x-, y-, z- data. Verify that the first and last points

in the curve file are the same for a closed profile.
3.

4
5.
6

Click Browse from the Curve File dialog box.

Browse to the SOLIDWORKS 2021 folder.

Set file type to Text Files.

Double-click cam2.text. View the data in the
Curve File dialog box. View the sketch in the

Graphics window. Review the data
points in the dialog box.

Click OK from the Curve File dialog
box. Curvel is displayed in the
FeatureManager. This curve can now be
used in a sketch (fully defined profile).
View the results of the fully defined
sketch using the curve.

Close the model.

Open Curve Through XYZ points 4-2
from the SOLIDWORKS 2021 folder to
view the final model and FeatureManager.

10. Close the model.

ICuwes (*.sldcrv)

\

v]

Curves (*.sldcrv) |

E

TopDownAssemblyModeling

Virtual Components

cam2

Curve File

~
‘ D:\20M SOLIDWORKS Reference Guide\SOLIDWOR

Browse...

Point X Y|
1 50mm Omm omi
2 49.99mm 0.88mm omi
g 49.97mm 1.78mm omi
4 49.93mm 2.68mm omi
5 49.88mm 3.61Tmm omi
6 49.82mm 4.54mm omi
7 49.75mm 5.49mm omi
8 49.66mm 6.44mm omi
9 49.56mm 741Tmm omi
10 49.46mm 8.39mm omi
11 AQ 2 ArArn O 27rmrm AN

A

Save

Save As

Insert

OK

Cancel
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Curve Through Reference Points e
The Curve Through Reference Points O tool provides the .
ability to create a curve through points located on one or

more planes. See SOLIDWORKS @ Help for additional %Split Line
information. @ Project Curve

U Curve Through XYZ Points
© curve Through Reference Point;
{8 Helix and Spiral

@ q’% 5‘ X M Composite Curve
elp

Point Sketch Entity SE RS
The Point Sketch entity tool provides the ability to insert points Point @
in your sketches and drawings. To modify the properties of a v

point, select the point in an active sketch, and edit the properties | Existing Relations ~
in the Point PropertyManager. The Point PropertyManager L

provides the following selections:
®  Under Defined

o Existing Relations. The Existing Relations box provides the |, reiations ~
following option: & Fix
e Relations. Display the automatic relations inferenced mrdldEiEeanEEs

during sketching or created manually with the Add b
Relations tool. The callout in the Graphics window is v

<> <>

highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.

e Add Relations. Add relations to the selected entity. Display
the relations which are possible for the selected entity.
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e Parameters. Specify the appropriate combination of parameters for your point only if
the point is not constrained by relations. The available parameters are:

e X Coordinate. Specify the x coordinate of your point.

¢ Y Coordinate. Specify the y coordinate of your point.

Centerline Sketch Entity ;%I =ik '619\0@
nsert Line
The Centerline Sketch entity > tool provides the ability to use VX
Message A

centerlines to create symmetrlcal sketch elements gnd revolved ' e Tl
features, or as construction geometry. The Centerline sketch entity | orsketchanewline.

uses the Insert Line PropertyManager. The Insert Line °”e"'©a“:" s ~
PropertyManager provides the following selections: O Horizonta
. . . . . . OVe ical
e Orientation. The Orientation box provides the following o An;e
options: Options ~
. . . . . . For construction
e As sketched. Sketch a line in any direction using the click O infinite length
and drag method. Using the click-click method, the As [ Midpoint line

sketched option provides the ability to sketch a line in any
direction, and to continue sketching other lines in any direction, until you double-
click to end your process.

e Horizontal. Sketch a horizontal line until you release your mouse pointer.
e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.

s
P

The angle is created relative to the horizontal.
e Options. Line types are:

¢ For construction. Selected by default. Convert the selected sketch entity to
construction geometry.

¢ Infinite length. Not selected by default. Create a line of infinite length which you
can later trim in the design process.

e Midpoint line. Create a line that is symmetrical from the midpoint of the line.

w1

“¥" Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.
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Text Sketch Entity

The Text Sketch A entity tool provides the ability to sketch text on
the face of a part and extrude or cut the text. Text can be inserted on
any set of continuous curves or edges. This includes circles or
profiles which consist of lines, arcs or splines.

w 1
“¥" Convert the sketch entities to construction geometry if the curve
is a sketch entity, or a set of sketch entities, and your sketch text is in

the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The
Sketch Text PropertyManager provides the following selections:

e Curves. The Curves box provides the following options:

e Select Edges, Curves Segment. Display the selected curves,

edges, sketches, or sketch segments.
Text. The options are:

Text. Display the entered text along the

SOLIDWORKS® 2021 Reference Guide

S BER O
/A\ Sketch Text ®

Curves

Text

Use document font

Font...

o U L

Trim Convert Offset
ntities Entities Entities

|| Text

selected entity in the Graphics window. If
you do not select an entity, the text is
displayed horizontally starting at the
origin.

Bold Style. Bold the selected text.

il Sketches text on any set of continuous curves or edges.
Select the curve or edge, then enter the text to display
under Text in the PropertyManager.

I}lil{l Mirror Entities

k.
Gk Linear Sketch Pattd

Italic Style. Italicize the selected text.
Rotate Style. Rotate the selected text.

curve or sketch segment.

edge, curve or sketch segment.

curve or sketch segment.

or sketch segment.

Flip. Flip the text.

text along an edge, curve or sketch segment.
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Left Alignment. Justify text to the left. Only available for text along an edge,

Center Alignment. Justify text to the center. Only available for text along an

Right Alignment. Justify text to the right. Only available for text along an edge,

Full Justify Alignment. Justify text. Only available for text along an edge, curve

Flip Vertical direction and back. The Flip Vertical option is only available for
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e Flip Horizontal direction and back. The Flip Horizontal option is only available
for text along an edge, curve or sketch segment.

e Width Factor. Widen each of your characters evenly by a specified percentage.
Not available when you select the Use document's font option.

e Spacing. Modify the spacing between each character by a specified percentage.
Not available when your text is fully justified or when you select the Use
document's font option.

e Use document's font. Selected by default. Clear the initial font and to choose
another font by using the Font option button.

e Font. Choose a font size and style from the Font dialog box.

Tutorial: Text 4-1

Apply text on a curved part. Use the Sketch Text % U C [l Miror Enties
tool. Z’%f{!& entes Etites 0 [ofe Lneer Sketch Pat
1. Open Text 4-1 from the SOLIDWORKS
2021 folder. The Lens Cap is displayed in the | ::’(t .
!l Sketches text on any set of continuous curves or edges.

GraphiCS window. Select the curve or edge, then enter the text to display
under Text in the PropertyManager.

2. Click Front Plane from the FeatureManager.
Apply the Text Sketch tool.

3. Click the Text A Sketch tool. The Sketch Text
PropertyManager is displayed.

4. Click inside the Text box.

5. Type SOLIDWORKS. SOLIDWORKS is displayed

horizontally in the Graphics window starting at the origin,
because you do not select an entity.

6. Click inside the Curves option box.

7. Click the front edge of Base Extrude. Edge<1> is displayed
in the Curves option box. The SOLIDWORKS text is
displayed on the selected edge.

8. Uncheck the Use document font box.
9. Enter 250% in the Spacing box.

10. Click the Font Button. The Choose Font dialog box is
displayed.

11. Select Arial Black, Regular, Point 14.

L
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12. Click OK from the Choose Font dialog box.

13. Click OK ¥ from the Sketch Text PropertyManager. Sketch7
is created and is displayed in the FeatureManager. Zoom in on
the created text.

14. Close the model.

L
“¥* If the curve is a sketch entity, or a set of sketch entities, and
the sketch text is in the same sketch as the curve, convert the

sketch entities to construction geometry.

SOLIDWORKS® 2021 Reference Guide

Plane Sketch Entity

©

EAEEC N

The Plane Sketch entity tool provides the ability for the user to | i Sketch Plane

add Reference entities to a 3D sketch. Why? To facilitate v X x

sketching, and to add relations between sketch entities. Once Message

you add the plane, you need to activate it to display its Select references (planes, sketch

properties and to create a sketch. The Plane sketch entity uses | entities: edges, faces orvertices) to
define the sketch plane. Then select

the Sketch Plane PTOPCTtYManager- the constraining relations to each

reference.

The Sketch Plane PropertyManager provides the following
selections:

o First Reference. Select Reference entities from the
FeatureManager or from the Graphics window. Select the
constraining relations to each reference. The available
relations selection is based on the selected geometry.

First Reference

©)

Fa

i

Second Reference

i

e Reference Entities. Display the selected sketch entity | Third Reference

or plane as the reference to position the 3D Sketch
plane.

L

e Select a relation. Select a relation based on the
selected geometry.

w s

“¥* The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.
The relations are based on existing geometry.
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e Second Reference. Select Reference entities from the FeatureManager or from the
Graphics window. Select the constraining relations to each reference. The available
relations selection is based on the selected geometry.

¢ Reference Entities. Display the selected sketch entity or plane as the reference to
position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected geometry.

o Third Reference. Select Reference entities from the FeatureManager or from the
Graphics window. Select the constraining relations to each reference. The available
relations selection is based on the selected geometry.

¢ Reference Entities. Display the selected sketch entity or plane as the reference to
position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected geometry.

w 1

“¥" With existing geometry, add a plane by referencing the entities that are present. Use
any number of references required to achieve the desired results.

Tutorial: Sketch Plane 4-1

B >
Add a 3D Sketch plane. Add a plane using references. Select 53 ‘ ‘ 5 ‘ ® ‘ @ ‘
two corner points of a 3D sketch. The corner points of the & sketch Plane 4.1 (Default<<Del
rectangle reference the position of the 3D sketch plane. ey
1. Open Sketch Plane 4-1 from the SOLIDWORKS [@sensors
» [A] Annotations
2021 folder. 5 Eqations
2. Edit 3DSketchl from the FeatureManager. 5; etk cirebpseiad
Front Plane
3. Click Tools > Sketch Entities > Plane. The Sketch [ Top Plane
. . [J Right Plar G2 1® 41
Plane PropertyManager is displayed. g oS &
;@E ' ‘ Go ) SDsket edit Sketch ky ggeh1)
Rename a feature or sketch for clarity. Slowly click Make Reference Sketc
the feature or sketch name twice and enter the new name CElmiwa
when the old one is highlighted. 5 if:ﬁ;ﬁ:'i;mre

Page 4 - 57



Design Intent, Sketching and Sketch Entities

4. Click the top front corner point of the rectangle
as illustrated. Point3 is displayed in the First
Reference box.

5. Click the bottom back corner point of the
rectangle. Point4 is displayed in the Second
Reference box. Click OK ¥ from the Sketch
Plane PropertyManager.

6. Close the model.

Route Line Sketch

SOLIDWORKS® 2021 Reference Guide

Entity

The Route Line Sketch entity tool
provides the ability to insert a
Route line between faces, circular

Ex... u

I

oute Line
Adds a route line that connects
entities in an explode line sketch or a
3D sketch.

@

edges, straight edges, or planar faces. The Route Line
Sketch entity is active when you:

e Create an Explode Line Sketch.
e Edit an Explode Line Sketch.
e Select the Route Line tool in a 3D sketch.

The Exploded Line Sketch tool &’ is a 3D sketch added
to an Exploded View in an assembly. The explode lines
indicate the relationship between components in the
assembly.

The Route Line Sketch entity o uses the Route Line
PropertyManager. The Route Line PropertyManager
provides the following selections:

e [Items To Connect. The Items To Connect option:

o Reference entities. Display the selected circular

%9 Route Line @
v X Bt
Items To Connect A
Options ~
|:| Reverse
Alternate Path
Along XYZ
e ac
¢ X M @
Exploded| Instant3D Update Take
View SpeedPak  Snapsh

Subassemblies

| &' Exp@ed View

@' Explode Line Sketch
%F'? Insert/Edit Smart Explode Lines

edges, faces, straight edges or planar faces to connect with your created route line.

e Options. The options are:

e Reverse. Reverse the direction of your route line. A preview arrow is displayed in

the direction of the route line.

e Alternate Path. Display an alternate possible path for the route line.

e Along XYZ. Create a path parallel to the X, Y and Z axis directions.

1.~

w1

* Clear the Along XYZ option to use the shortest route.
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Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line
Sketch entity.

1.

Open the Route Line 4-1 assembly from the
SOLIDWORKS 2021 folder. The assembly is
displayed in an Exploded view.

Click the Explode Line Sketch % tool from
the Assembly toolbar. The Route Line
PropertyManager is displayed.

Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards
the back. If required, check the Reverse
direction box. Face<1> @Shaft-Collar-1 is
displayed in the Items To Connect box.

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<1> component.
Face<2>@pFlatbar-1 is displayed in the Items
To Connect box. The arrow points towards the
right.

Click the inside face of Cut-Extrude5 of
RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box. The
arrow points towards the back.

Click the inside face of the second Cut-
Extrude5 feature of RodClevis<1>. Face<4>@)
AirCylinder-1 is displayed in the Items To
Connect box.

Click the inside face of the top hole of Cut-
Extrudel of the Flatbar<2> component.
Face<2>@Flatbar-2 is displayed in the Items
To Connect box. The arrow points towards the
back.
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Cut-Extrude1 of Shaft-Collar<1>

o ;\\ Cut-Extru
\

Cut-Extrude5
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8. Click the inside face of Cut-
Extrudel of SHAFT-COLLAR<2>.
The direction arrow points towards
the back. Face<1> (@Shatft-
Collar<2> is displayed in the Items
To Connect box.

9. Click OK ¥ from the Route Line
PropertyManager. View the created
Route Line.

10. Click OK ¢ from the
PropertyManager to return to the
FeatureManager.

Fit the model to the Graphics window.
Display an Isometric view.
11. Press the f key to fit the model to the Graphics window.

12. Click Isometric view. View the results.
13. Close the model.

A% SOLIDWORKS provides the ability to create a Bill of
Materials (BOM) in an assembly. The BOM is displayed in the
Tables folder of the FeatureManager. See the Assembly section

for additional information.

SOLIDWORKS® 2021 Reference Guide

&

Cut-Extrude1 of S

FER S
@5‘" Route Line @
v x|z

Items To Connect S

@ Face<1>@Shaft-Collar-1
Face<2>@Flatbar-1
Face<3>@AirCylinder-1/Roq
Face<4>@AirCylinder-1/Rod

‘Face<1 >@Shaft-Collar-2

Options A
D Reverse
Alternate Path
Along XYZ

w1

4" Inan exploded view assembly, create explode
route lines automatically for selected components by s
using the Inset/Edit Smart Explode Lines command.

Tutorial: Route Line 4-2

=S @ 9

"xploded View
@-ﬂ? Explode Line Sketch
%ﬁ? Insert/Edit Smart Explode Lines

Update Take Large
Speedpak Snapshot Assemi
Setting|

Edit an Explode Line Sketch.

1. Open Route Line 4-2 from the SOLIDWORKS
2021 folder. The Route Line 4-2 Assembly
FeatureManager is displayed.

2. Click the ConfigurationManager tab.
3. Expand Default.

4. Right-click ExplViewl from the
ConfigurationManager.

5. Click Explode. View the results in the Graphics
window.

6. Expand ExplViewl.
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Edit the Explode Line Sketch.
7. Right-click 3DExplodel from the
ConfigurationManager.

8. Click Edit Sketch.
9. Display a Top view.
10. Click Centerline - from the Sketch

toolbar. The Insert Line PropertyManager is
displayed.

11. Click the endpoints of the Route Line as
illustrated.

Create a new path.
12. Click a point to the right of the Route Line
endpoint and over the top of the axle.

13. Click a point below the axle as illustrated.

Design Intent, Sketching and Sketch Entities

==

o - L

14. Click a point to the left of the axle over the Flatbar.

15. Click a point below the Flatbar.
16. Click a point above the SHAFT-COLLAR.
17. Click a point below the Shaft-Collar.

Deselect the active Sketch tool.
18. Right-click Select in the Graphics window.

19. View the results.

20. Return to the FeatureManager design tree.
21. Close the model.

w 1

“¥" In an exploded view assembly,
create explode route lines
automatically for selected
components by using the Inset/Edit
Smart Explode Lines command.
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Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for
pulleys or sprocket mechanisms. The Belt/Chain feature
simulates a cable-pulley mechanism. The Belt/Chain entity uses
the Belt/Chain PropertyManager.

AR In the past, it was difficult using SOLIDWORKS to
effectively model components such as cables, chains, and timing
belts due to their flexible motion. The shapes of these items
could change over time. This made it difficult to examine the
way a belt would interact with two or more pulleys, or a cable
system shifts a lever, or crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following
selections:

Belt Members. The Belt Members options are:

e Pulley Components. Display the selected arcs or

circles for the pulley components.

Up arrow. Move the selected pulley component
upwards in the displayed order.

Down arrow. Move the selected pulley component
downward in the displayed order.

Flip belt side. Change the side on which the belt is
located in the pulley system.

Properties. Define the following belt conditions. The
options are:

e Driving. Cleared by default. Calculate the length of
your belt. When checked, enter a value if you do not
want the system to calculate your belt length. Based
on the constraints, one or more of the components

may move to adjust for the length of the belt.

Use belt thickness. Specify the thickness value of the
belt.

Engage belt. Selected by default. Disengage the belt
mechanism.

[

w1
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S ERIS @
Belt/Chain @

v X
Message 2
Select the circle or arc to define belt
members around which the belt will
pass
Belt Members ~
0 Arc1/40MM_Circle-1

Arc1/20MM_Circle-1

Arc1/60MM_Circle-1

Flip belt side

Properties
Belt Length:

Driving

o

Use belt thickness

20.00mm :

Engage belt

~) [ ©

: Only circle entities in a block can be selected for a belt member.
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Blocks S ER [T
. . . o & Make Block

Blocks are a grouping of single or multiple sketch entities. In Il ®
SOLIDWORKS, the origin of the block is aligned to the M
orientation of the sketch entity. Previously, blocks inherited Block Entities A
their origin location from the Parent sketch. Additional Line1
enhancements to Blocks are: stz

Line3
e Modeling pulleys and chain sprockets. Line4

Line5
e Modeling cam mechanisms.
Blocks are used in the Belt/Chain sketch entity. You can Insertion Point -~
create blocks from a single entity or multiple sketch entities.  |[]Layout Sketch Block

Drag Manipulator on-screen to

Why should you use Blocks? Blocks enable you to: position insertion point.

Create layout sketches using the minimum of dimensions
and sketch relations.

Freeze a subset of sketch entities in a sketch to control as a single entity.
Manage complicated sketches.

Edit all instances of a block simultaneously.

w1

“¥* Use blocks in drawings to conserve drawing items such as standard label positions,

notes, etc. See SOLIDWORKS Help for additional information.

Blocks toolbar Blocks |

The Blocks toolbar controls blocks in sketching. The @

Blocks toolbar provides the following tools:

Make Block. The Make Block 1 tool provides the ability to create a new block.

Edit Block. The Edit Block tool provides the ability to add or remove sketch
entities and to modify dimensions and relations in your sketch.

Insert Block. The Insert Block A% tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

Add/Remove. The Add/Remove (e tool provides the ability to add or remove sketch
entities to or from your block.

Rebuild. The Rebuild IE. tool provides the ability to update the parent sketches
affected by your block changes.
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e Saves Block. The Saves Block tool provides the ability to save the block to a file.

Adds an .sldblk extension.

e Explode Block. The Explode Block tool provides the ability to explode the

selected block.

e Belt/Chain. The Belt/Chain @¢ tool provides the ability
to insert a belt.

w1

e Exploding a single instance of the block only affects
that instance of the block.

Tutorial: Block 4-1
Create a Block using the Blocks toolbar.

1. Create a New L) part. Use the default ANSI Part
template.

2. Click Top Plane from the FeatureManager. This is your
Sketch plane.

3. Sketch a closed sketch using sketch entities as
illustrated. The sketch consists of five lines.

i [e]
4. Click Make Block IN from the Block toolbar or click
Tools > Blocks » Make. The Make Block
PropertyManager is displayed.

5. Box-select the sketch entities from the Graphics
window. The selected sketch entities are displayed in the
Block Entities box.

6. Expand the Insertion Point box. Note the location of the
insertion point.

7. Click OK ¥ from the Make Block PropertyManager.
Block1-1 is displayed in the FeatureManager.

8. View the results.
9. Close the model.
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w1

‘¥* Create a block for a single or combination of multiple
Sketch entities. Saving each block individually provides you
with extensive design flexibility.

Tutorial: Belt-chain 4-1

Use the Belt/Chain Sketch entity function. Create a pulley sketch.

1. Open Belt-chain 4-1 from the SOLIDWORKS 2021 folder.
View the three created blocks in the Belt-chain
FeatureManager.

2. Edit Sketchl from the FeatureManager.

Click Tools » Sketch Entities >
Belt/Chain. The Belt/Chain
PropertyManager is displayed.

4. Select the three circles from left
to right. The select circles are ®
displayed in the Belt Members \A® l‘
dialog box.

Check the Driving box. Q
Enter 460mm for Belt Length. 2
Check the Use belt thickness box.
Enter 20mm for belt thickness.
| | @

Click OK ¥ from the Belt/Chain %= ('a))

PropertyManager.
10. Expand Sketchl. Belt1 is created @
and is displayed in the N
FeatureManager.

o © =N w

11. View the results.
12. Close the model.

w1

A View SOLIDWORKS Help for additional information.

The Select Chain command has been enhanced to allow you to
select construction entities. See SOLIDWORKS Help for
additional information.
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

e (Create a sketch.
e C(Create a feature from the sketch.

¢ In the FeatureManager design tree, select the same sketch used to create the first
feature.

e C(Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is
identified by the Shared &% icon.

s

“¥ Add additional sketches as required to create the features. For example, if one
feature 1s an extrude and the other feature is a revolve use the same sketch for both
features but add a centerline to create the revolve.

Tutorial: Shared Sketch 4-1 @ Blol@ T
Create an Extrude Thinl feature with a shared sketch. @) Boss-Extrude ©)
1. Open Shared Sketch 4-1 from the SOLIDWORKS 2021 v X ®
fOldeI‘. From A
2. Click Sketchl from the FeatureManager. View the sketch in . t_Sk Ih g .
the Graphics window.
3. Click Extruded Boss/Base & from the Feature toolbar. 4
4. Select Mid Plane for End Condition in Direction 1. (&
Merge result
5. Enter 16.00mm fOT Depth
6. Check the Thin Feature Draft outward

Thin Feature A

&y [4.50mm E

Selected Contours ~

<> Sketch1-Contour<1>

dialog box.

7. Enter 4.50mm for
Thickness.

8. Click the Reverse
Direction button.

9. Click inside the Selected
Contours dialog box.

!
!
[
|

10. Click the circumference of the large circle in the Graphics
window.

11. Click OK ¥ from the PropertyManager.
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12. Expand Extrude-Thinl in the
FeatureManager. View the
Shared sketch.

13. Close the model.

v @ Boss-Extrude1

Sketch1
@Extrude-Thirﬂ
‘é,, Sketch1

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found, and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities: Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line, and Belt/Chain.

You utilized and addressed the following toolbars: Block toolbar and Spline toolbar and
applied the Instant3D tool.

Fully define all sketches in the model. However, there are times when this is not
practical, generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are
ultimately incorporated into the part. Construction geometry is ignored when the sketch is
used to create a feature. Construction geometry uses the same line style as a centerline.

1 .-

* Press the Tab key to change planes in a 3D Sketch.

L
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You can transition from sketching a line to sketching a Tangent Arc, and vice versa,
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and
enter the new name when the old one is highlighted.

The plane or face you select for the Base sketch determines the orientation of the part.

w s

‘¥ The PropertyManager remembers its last used state.

Chapter 5 provides a comprehensive understanding of the available Sketch tools,
Geometric relations, Dimensions/Relations tools and the DimXpertManager in
SOLIDWORKS.
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